
 NCSA Mosaic for Microsoft Windows
       Installation and Configuration Guide

        

IMPORTANT!

Before you begin, make sure you are using v1.1.5a of the Win32s software.  It is available from
Microsoft's anonymous ftp server and you can find the file Win32s115a.Zip in the 
/developr/win32dk/sdk-public directory.    For the convienence of our users we also mirror a copy 
of this software on our ftp site, ftp.ncsa.uiuc.edu.  However, we have added a readme file and 
we've re-zipped it into a file called win32s.zip.  You can find win32s.zip in the 
/PC/Windows/Mosaic/ directory of our anonymous ftp server.   

You MUST use Win32s version 1.1.5a!

Introduction

This is a step-by-step guide to installing and configuring NCSA Mosaic for Microsoft Windows. 
This guide assumes that your system meets one of the following Operating System criteria:

  - Microsoft Windows NT

  OR 

  - Windows v3.1, with a winsock.dll and the win32s (version 1.1.5a) software properly installed 
    and configured.
  OR

  - Windows for Workgroups, using the current TCP/IP stack from Microsoft.

We also assumes the following about your system:

- Your system is connected to the Internet.

- You have an ftp client and the Shareware product pkunzip, version 2.04g.
  
  
Acquiring Software from NCSA

Since you are reading this file, you probably already have all of the software required for NCSA 
Mosaic.  If that is the case, you can skip this section.  However, if you don't have a winsock.dll or 
the Win32s software you will find the information in this section very useful.  If you have never 
downloaded files from NCSA's server, we recommend you read the file README.FIRST now.  It 
provides useful information that may facilitate later steps in the installation process.

The current version of  Mosaic can be obtained by following instructions.  

Log on to NCSA's Anonymous FTP server using what ever ftp tool you have access to.    The 
address for our server is ftp.ncsa.uiuc.edu.  At the login prompt enter the name anonymous.  

anonymous

At the password prompt enter your email address as the password
jdoe@business.com



Change directories to PC/Mosaic.
cd PC/Windows/Mosaic

List the contents of the directory, using the command:
 ls

Tell the server you are going to transfer a binary file by giving the command:
bin

Get the Mosaic and the Win32s software using the command:

get wmos20a7.zip

If you need the Win32s then:

get win32s.zip  (if your system doesn't have version 1.1.5a of
           win32s software)



If you need the Trumpet winsock, continue with the following commands:
       cd sockets
       get winsock.zip

The file extension .zip indicates a compressed archived file.   If you have the latest version of the 
Pkzip software, execute the following command to retrieve the files from the compressed archive:

pkunzip wmos20a6.zip

If you need a copy of the SHAREWARE utility PKWare (zip and unzip), you can find it on our ftp 
server in the /PC/Windows/Mosaic/zip directory.  The file, pkz204g.exe, is a self extracting 
executable file.  We recommend you put it in it's own directory and just type pkz204g.  The 
software will unzip itself.  After you extract the software you will need to add this directory to the 
PATH statement of your autoexec.bat file and reboot your machine

Confirming the Files

Once you have downloaded and uncompressed the NCSA Mosaic files, the installation process is
straightforward.  Check to make sure all of the following files exist in the mosaic directory:

update.wri Current list of this version's enhancements
and bug fixes in Write format.

install.wri This guide in Microsoft Write format
mosaic.exe The NCSA Mosaic executable
mosaic.ini The initialization and configuration file 

for Mosaic
faq.wri    A list of Frequently Asked Questions (FAQs)
slip.txt Information about using Mosaic over a phone line using

 the SLIP interface.

If you want to review the list of Mosaic enhancements and bug fixes since the last version, you 
should read the file update.txt.  If you would like to read the entire enhancement list, you can do 
so on-line.  Use Mosaic, go to our home page:

http://www.ncsa.uiuc.edu/SDG/Software/WinMosaic/HomePage.html

Select the "Features" link.



Mosaic is a 32-bit Application

Mosaic is a 32-bit application and it requires Microsoft's Win32s software.  Win32s allows you to 
run 32-bit Windows applications in the Windows 3.1 and Windows for Workgroups environments. 
Win32s was developed by Microsoft and it is freely distributed to licensed users of Windows 3.1 
or Windows for Workgroups.  This software is currently under development at Microsoft and their 
latest release is version 1.1.5a  If you don't have it, GET IT.  If you are using an earlier version 
of Win32s, you must install version 1.1.5a  before you can run Mosaic.  You can find the file 
win32s.zip in the /PC/Windows/Mosaic directory on ftp.ncsa.uiuc.edu.  

 *******  WIN32S v1.1.5a MUST BE INSTALLED BEFORE YOU RUN MOSAIC  *******

Checking the WinSock DLL

NCSA Mosaic is a WinSock 1.1-compliant program and requires that you have a WinSock 1.1-
compliant sockets DLL (winsock.dll) installed to provide the TCP/IP networking under windows.  
Check your WinSock implementation's installation guide to see whether it is WinSock 1.1-
compliant.

If you are using a commercial TCP/IP stack such as PC-NFS, or running on a local area network 
such as Novell in addition to the TCP/IP, you must obtain the winsock.dll directly from your 
respective vendor.

If your WinSock DLL is not WinSock 1.1-compliant or you do not have commercial TCP/IP stack 
software, you can use a tested shareware winsock.dll from Trumpet Software.  You can find the 
latest version of the Trumpet WinSock at the anonymous FTP server ftp.utas.edu.au in the 
directory /pc/trumpet/winsock.  We also mirror a copy of this software on our anonymous site,
ftp.ncsa.uiuc.edu.  You can find winsock.zip in the /PC/Mosaic/sockets directory.  For more 
information about winsock.dll's I suggest you refer to the faq.txt file.

Configuring NCSA Mosaic

To configure NCSA Mosaic, first copy the file mosaic.ini into your windows directory.   Typically, 
this directory is c:\windows unless you have specified it otherwise. This is very important because
NCSA Mosaic will not otherwise recognize and save configuration changes to this initialization 
file.  We also recommend you leave a copy of mosaic.ini in your mosaic directory as a back-up 
file.

If you are administrating a network site, and want to have one copy of Windows, and can't put 
mosaic.ini in the Windows directory, use the environment variable MOSAIC.INI to specify the path
name of the INI file.  The environmental variable is defined in your autoexec.bat file.  i.e.

set MOSAIC.INI=c:\complete\directory\path\mosaic.ini

Edit your  mosaic.ini file.  If you open up the File Manager and double-click on the c:\windows\
mosaic.ini file, Windows will open up the Notepad editing environment.  In general users will not 
usually need to modify fields that are not mentioned in the following discussion.
For a complete description of the mosaic.ini file see our on-line information at:

http://www.ncsa.uiuc.edu/SDG/Software/WinMosaic/WinMosaicInstall.html



NOTE:  There has been additions to the mosaic.ini file with the release of Alpha 6.  

The Main section:

[Main]

E-mail="jdoe@business.com"

If you can be reached via Internet email, put your full email address in quotes in the E-mail field.  
This is used for annotations and for a return address when you select Mail to Developers.  If your 
login ID is jdoe and you work at Business, Inc., your email entry might read as follows:

Autoload Home Page=yes

If you do not want NCSA Mosaic to automatically load a home page document every time you use
Mosaic, set Autoload Home Page to no.

Home Page=http://www.ncsa.uiuc.edu/SDG/Software/WinMosaic/HomePage.html

This statement defines where the home page you regularly visit is.  As distributed, NCSA Mosaic 
points to the NCSA Mosaic for Microsoft Windows Home Page on NCSA's Web server.  We hope 
you will explore our on-line information.

Help Page=http://www.ncsa.uiuc.edu/SDG/Software/WinMosaic/Docs/WMosTOC.html
A Help link to our online user documentation

FAQ Page=http://www.ncsa.uiuc.edu/SDG/Software/WinMosaic/FAQ.html
A Help link to our Frequently Asked Questions

Bug list=http://www.ncsa.uiuc.edu/SDG/Software/WinMosaic/Bugs.html
A Help link to our Bug and Bug Like Features page

Feature Page=http://www.ncsa.uiuc.edu/SDG/Software/WinMosaic/Features.html
A Help link to the Mosaic Features page

If you are a current Mosaic user, these are the additional parameters that need to be added
to mosaic.ini file.  If you are a new user, these additional parameters have been included in
the default mosaic.ini file.  These parameters provide convenient links from the Help pull-
down menu to the revelant information. 

Display Inline Images=no

If you will be using Mosaic over a slow network connection and do not want inline images to be 
automatically transferred, set Display Inline Images to no.  Inline images will be replaced with an 
NCSA logo.  If you want to see a the image represented by the NCSA logo click on it with the right
mouse button and Mosaic will retrieve the image.

Grey Background=yes



The Grey Background entry allows you to specify whether the NCSA Mosaic window has a white 
(no) or grey (yes) background.  Many documents posted to the Web are tuned to a grey 
background:



Fancy Rules=yes

Fancy Rules toggles a different style of drawing horizontal rules in HTML documents (the <hr> 
tag.)

Round List Bullets=yes

List bullets slow down drawing documents.  If you are a speed maven, you may wish to turn on 
simplified bullet drawing (line bullets instead of round bullets.)

Anchor Underline=yes

If you are using a black and white monitor you will probably want to underline the hyperlinks.  If 
you are using a color monitor we recommend you do not use this feature.  Anchor Underline=no 
will improve the performance of Mosaic.

Anchor Cursor=yes

Allows the hyperlink to change to the color specified in the [Settings] section.

Show URLs=yes

An option that allows the URL to be displayed in the status window.  Note: You must also select 
"Status bar=yes" for this option to be useful.

Extended FTP=yes

An option available that will iconify the file types and show the size of the files.

Toolbar=yes

An option that allows the toolbar to be displayed at the top of the Mosaic window.

Status bar=yes
An option that allows the status bar to be displayed at the bottom of the Mosaic window.

Title/URL bar=yes

An option that allows the Document Title:, Document URL, and the NCSA logo to be displayed in 
the Mosaic window.



The Settings section:

[Settings]

Anchor Color=0,0,255

The anchor color is the color of the hyperlink anchors that appear in an NCSA Mosaic document. 
You may set the anchor color to any valid RGB (red, green, blue) combination.  The RGB values 
must be separated by commas and can range from 0 to 255.  The default color is blue (0,0,255).

Mail section:

[Mail]

Default Title="WinMosaic auto-mail feedback"

Edit the Default Title to contain the message you want to have appear in the subject line when 
you send email to the NCSA developers via the Mail to Developers selection on the Help menu.  
As distributed, NCSA Mosaic enters the phrase "WinMosaic auto-mail feedback":

Services section:

[Services]

NNTP Server="news.cso.uiuc.edu"

If you want to use NCSA Mosaic's news support, set your network news (NNTP) server here.  As 
distributed, NCSA Mosaic specifies the University of Illinois' NNTP server and you will have to 
specify your local news server.

SMTP Server="ftp.ncsa.uiuc.edu"

NCSA Mosaic uses the SMTP server specified here to send mail back to the NCSA developers 
when you select Mail developers from the Help menu. As distributed, NCSA Mosaic specifies 
NCSA's FTP server because it is known and almost always available.   If you have a local SMTP 
server, you should enter it accordingly.



Viewers section:

[Viewers]

This section contains two subsections.  The first subsection contains a list of file types in MIME 
(Multipurpose Internet Mail Extensions) form.   The second subsection specifies the viewer for 
each of the listed file types.  This information is used to determine whether an external viewer 
must be launched to view a file and, if so, which viewer to launch.

If necessary, edit the */* entries in the second Viewers subsection to point to your viewers.  If you 
do not have a viewer for a file type, you can leave the line alone.  You may add arbitrary 
spawning of external viewers by defining a new TYPE#, specifying a viewer, and optionally 
providing a suffix list.  See the faq.txt file for specific information.

NCSA Mosaic must use telnet to connect to some information servers.  To do so, NCSA Mosaic 
needs to know where to find the telnet application on your system.  Specify the full pathname for 
your telnet application in the telnet entry at the END of the Viewers section.  For example:

. 
telnet="c:\trumpet\telw.exe"

Suffixes section:

[Suffixes]

This section lists the filename suffixes used to identify the file types of files retrieved via FTP or 
from HTTP version 0.9 servers.  In such situations, NCSA Mosaic uses the information in this 
section and in the Viewers to determine whether an external viewer must be launched to view a 
file and, if so, which viewer to launch.  Files that reside on HTTP version 1.0 servers are typed by 
the server and only the information in the Viewers section is used.

NOTE: If you are retrieving information from an HTTP/1.0 server (most World Wide Web servers 
are), the server automatically types data for you.  The extensions you set up in the Suffixes 
section will not have any effect on what MIME type the document is assumed to be, because the 
data is already being typed by the server.

You may list any number of filename extensions for a given file type; simply separate them by 
commas.

The last suffix listed will be used when writing a file of that type to the local hard drive.  If your 
external viewer requires a particular extension, make sure that it is listed last.

Consider the example of the JPEG file type.  The line

image/jpeg=.jpeg,.jpe,.jpg

indicates that any file with the suffix .jpeg, .jpe, or .jpg is a JPEG image.  Now look at the 
preceding section of the file.  The lines

TYPE3="image/jpeg"
and

image/jpeg="c:\windows\apps\lview\lview31 %ls"

define a JPEG image as TYPE3 and identify the required external viewer.  Using the information 



in the Suffixes and Viewers sections of this file,  NCSA Mosaic will recognize files with the 
extensions .jpeg, .jpe, and .jpg  as JPEG images and know that it must launch the external viewer
lview31 when it encounters them.

Viewers specified in this section must be able to take a specified filename as a command line 
argument.

Annotations section:

[Annotations]

Change the Directory entry to point to the directory on your local hard disk where you want to 
store personal annotations.

Change the Default Title to the title you want to use for your personal annotations.

User Menu sections:

[User Menu1], [User Menu2], etc.

This section specifies the user-configured menus.  NCSA Mosaic will accommodate up to twenty 
user-configurable menus in any combination of top level and pop-out menus.  Top level menus 
(Menu_Type=TOPLEVEL) will show up in the main menu bar; otherwise, the menu must be listed
as a pop-out from one of the top level menus.  Each menu will accommodate up to forty entries.
Note: The definition of a menu within another menu is considered one of the forty entries of that 
top menu.

YOU SHOULD USE Mosaic's  "Navigate, Menu Editor... " FUNCTION WHEN EDITING THIS 
SECTION.  HAND EDITING CAN RESULT IN PROBLEMS WITH YOUR MENUS.

User-configured menus are specified as follows.  The first line indicates the number of the menu 
while the next one or two lines name the menu and specify whether it is a top level menu.  If the 
second user-configured menu is to be a top level menu named Demos, the first three lines of the
menu specification would be

[User Menu2]
Menu Type=TOPLEVEL
Menu Name="Demos"

If the menu is to be a pop-out menu, omit the second line above.

These initial lines are followed by several lines specifying the items (Item#) in the menu.  Each 
Item# line must begin with Item#= and the rest of the line must be in one of the following formats. 
A line specifying a hotlink must list a document and the URL with which it can be located 
separated by a comma:

Item1=Vatican Exhibit, 
http://www.ncsa.uiuc.edu/SDG/Experimental/vatican.exhibit/Vatican.exhibit.html

A line specifying a menu separator must contain the word SEPARATOR:
Item2=SEPARATOR



A line specifying a pop-out menu must contain the word MENU and the number of the pop-out 
menu, taken from the first line of another user-configured menu, separated by a comma:

Item3=MENU,User Menu4

HotList section: 

[HotList]

The QUICKLIST URLs are stored in this section.  The QuickList is a list of URLs that is not 
displayed as a pull down menu.  It is displayed when you select File, Open URL... and the 
"Current Hotlist is:" window is pointing to QUICKLIST.  When these environmental variables are 
set properly, you can select any URL that is contained in the list by scrolling to it and clicking
on it.  Mosaic will retrieve this information when you click the OK button.  The advantage of 
having the QuickList is there is no size restriction on the list.

YOU SHOULD USE Mosaic's  "Navigate, Menu Editor... " FUNCTION WHEN EDITING THIS 
SECTION.  HAND EDITING CAN RESULT IN PROBLEMS WITH YOUR MENUS.

To add a URL to the QuickList simply open up Navigate, Menu Editor... and  ensure QUICKLIST 
is selected in the "Current Hotlist is:" window.  Now, simply select "Insert..." and the current URL 
will be added to your QUICKLIST.  

You can add URLs to any menu that is recognized by the menu editor.  To change menus, click 
on the arrow key next to the "current Hotlist is:" window and select the desired menu in the box.  
Now you have Insert..., Copy Item, Delete and Edit... control over the contents of that menu.

Note:  The easiest way to add a file to your Current hotlist is to use the open the Navigate pull 
down menu and select the "Add Current to Hotlist" function.

Document Caching section:

[Document Caching]

Type=Number
Number=2

This sections tells NCSA Mosaic how many documents to cache so that you do not have to return
to the network to retrieve a recently viewed document.  As distributed, NCSA Mosaic caches two 
documents.

If you have lots of memory on your system, you can increase the cache number.  If you have little 
memory, you may wish to decrease the number.  If you want to turn caching off, set it to 0 (zero).



Font sections:

[Normal Font], [Heading1 Font], [Heading2 Font], etc..

Do not edit this section directly; all font changes must be made from the Options menu.

Main Window section:

[Main Window]

Do not edit this section directly; adjust the NCSA Mosaic window size with the mouse and select 
File, Save Window Position to save the current size of the window, the position of the window and
your preferences.

[proxy information]

http_proxy=http://aixtest.cc.ukans.edu:911/
ftp_proxy=http://aixtest.cc.ukans.edu:911/
wais_proxy=http://aixtest.cc.ukans.edu:911/
gopher_proxy=http://aixtest.cc.ukans.edu:911/

For more information about using Mosaic through a firewall I suggest you read the information 
that is available in the faq.txt and the information that is available on-line at the following URL: 

 http://www.ncsa.uiuc.edu/SDG/Software/WinMosaic/ProxyInfo.html

If you are not on line you can find more information about proxy gateways in the faq.txt file.

    -------------- End mosaic.ini Information  ---------------

Finding Viewers

NCSA Mosaic for Microsoft Windows uses external viewers and players to display certain types of
files, such as JPEG images or MPEG movies.  These viewers and players are separate 
applications and they are neither maintained nor formally distributed by NCSA.

However, NCSA is always watching for particularly suitable viewers and players.  When one is 
located that NCSA can legally distribute, a copy is placed on NCSA's FTP server in the directory 
PC/Windows/Mosaic/viewers.  If you do not have a viewer or player for a particular file type, 
check
this directory.  If you find a viewer or player for a common data type that is not in this directory, or 
is significantly more useful than the one on our server, please let us know about it.  (One way to 
communicate that information is to select Mail to Developers on the Help menu.)  You can also
download these viewers from Mosaic.  See the following URL for more information:

     http:www.ncsa.uiuc.edu/SDG/Software/WinMosaic/viewers.html

Installing into Microsoft Windows



You are now ready to install NCSA Mosaic into the Microsoft Windows system. Select New... on 
the Program Manager's File menu.  Select Program Item and click on OK to add NCSA Mosaic to 
a Program Group.



Executing and Testing NCSA Mosaic

Ensure you have installed your winsock.dll and win32s.dll properly and execute NCSA Mosaic.  If 
everything is properly configured and your networks domain name server is up, NCSA Mosaic will
be able to load documents successfully.  Test this by clicking on the house icon in the toolbar.  
This is the quick link to a home page and by default this link is the Mosaic for Microsoft Windows 
Home Page.

If NCSA Mosaic hangs on execution or misbehaves in any other unexplained fashion, the most 
likely source of the problem is the WinSock DLL.  See "Checking the WinSock DLL" near the 
beginning of this guide and/or the faq.txt file for possible solutions to the common causes of this 
problem.

If you are able to execute NCSA Mosaic but selecting Windows Mosaic Home Page did not work, 
try the following exercises and include the results in your query to NCSA.  The results will help 
NCSA technical support determine the nature of your problem:

  1. Select Open Local File on the File menu and try to open a file on your system.

  2. Select Open URL on the File menu and try to open an HTTP file on remote Web server.  The 
URL

http://www.ncsa.uiuc.edu/General/UIUC/UIUCIntro/UofI_intro.html

will provide a good test.

  3. Select Open URL on the File menu and try to open an FTP file on a remote Web server.  The 
URL file://ftp.ncsa.uiuc.edu/PC/Mosaic/faq.txt will provide a good test.

Feedback to NCSA

Your comments on NCSA Mosaic are important; user feedback is an integral part of the Software 
Development Group's (SDG's) planning activities.  Bug reports are particularly valuable because 
SDG's tests cannot duplicate all user environments and equipment configurations.  Bug reports 
should include enough information to enable SDG developers to reproduce the problem.  Please 
specify any information given by Mosaic, and give us a URL so we can successfully reproduce 
the problem.  However, before you send any bug reports, comments, or suggestions, please 
check our on line information to ensure your information has not already been reported. This will 
be very helpful to us because we are swamped with email!  You can find on-line information about
known bugs, enhancement requests, FAQ's, viewers, etc. from our home page. 

       http://www.ncsa.uiuc.edu/SDG/Software/WinMosaic/HomePage.html 
                                                                    
If the answer to your question is not included in the above sources of information, we will attempt 
to reply as quickly as possible.  Please remember we are supporting NCSA Mosaic and we can 
not provide information about the location of specific resources on the net.  The easiest way to 
mail us is to click on Help, Mail to Developers... and write your message.  When you are finished 
just click Send and we will get your message.

Thank you for your understanding,

Mosaic for Windows Technical Support
mosaic-win@ncsa.uiuc.edu


